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You, Too, Can Draw Pictures 

The Software Design That Stimulates Creative Minds 

l We developed an interface that is easy to understand for beginners and can 

meet the expectation of experienced users.  

l It hides idle windows and allows you to draw in full screen mode, providing an 

environment where you can focus on your creative work. 

l Although this is vector graphics, it realized the feeling of bitmap drawing 

software use.   

Good Boy! Pen: Shape-Memory Drag Pen 

l You can correct the distortion of lines by stroking the pen as you say, “Good 

boy.” repeatedly. 

l You can transform a drawn shape with the “shape-memory drag pen” as it 

retains the original shape to a certain extent. You can correct the shape as you 

see it. 

Dynamic Color Change  

l Colors on the canvas can easily be changed later. You do not have to change 

the same color on multiple places on the canvas one after another, no matter 

how many places are colored with that color.     

Full basic functions  

l It has, of course, the basic functions, such as the drawing tool to draw straight 

lines, quadrilaterals, and circles, a layering function and a gradation function. 

Also, it is full of PICMO’s original ideas.  
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Making An Animation in 10 Minutes 

You can make an animation as easy as playing with a stuffed animal 

l We developed a technology that naturally changes the shape of the drawing by 

moving the arms and legs of the character just like you play with a stuffed 

animal.  

l By recording the movement of the mouse that is operating the shape 

transformation, you can create an animation in no time.  

 

Fully equipped with functions for correction and support   

l “Metronome function” that is useful for timing. 

l “Track editing function” that allows you to edit recorded animation. You can, of 

course, use the Good Boy! Pen and the Shape-Memory Drag Pen, for editing. 

Create complicated movements  

l “Baton Mode” is available (Pro only) to create complicated animations. 

l Just like general animation software, you can make hand-drawn key-frames, 

as well (Pro only). 
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Easy 

to Exchange and Release Data 

YouTube posting function included 

l You can post your creation on YouTube by just choosing it from the menu.  

l You can choose either your YouTube channel and/or PICMO’s common 

channel to post.   

File export in various formats  

l Flash SWF format export available. You can release it to the WEB quickly. 

l QuickTime format export available. You can record your work on a DVD or 

video by combining with video editing software. Data export to an iPod is also 

easy. 

l Of course, export in general still-image format (png, jpeg, and svg) is available, 

too. Animation can also be recorded in sequential still images. 

Capable of importing a bitmap file 

l You are capable of importing a bitmap file, such as jpeg and gif. The imported 

images can be used to make animations. Use photos taken with a digital 

camera to make your original animation.  

Windows version and Macintosh version available 

l PICMO has released both a Windows version and a Macintosh version 

simultaneously.    Of course, the data of drawing and animation can be read 

with both platforms. 

When you drag control points (●) , the form of the character changes naturally. Record 

the movement to create an animation in no time.   
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Operating Environment 

Please check your PC’s operating environment before installation. PICMO operates 
under the following environment.  

Windows PC 

OS：Windows XP、Windows Vista、Windows 7  （We do not have PICMO 

exclusively for 64-bit version, but can be used with 64-bit machine without any 

problem）	
  

CPU：Pentium4, 2GHz or higher 

Memory: At least 512MB (2GB or more is recommended) 

Must have working audio device, and speaker or headphone is connected 

Java Runtime Environment (JRE) 1.5.0 or higher（Included in installer) 

QuickTime 7or higher 

Macintosh 

CPU：Intel Mac 

OS：Mac OS X v10.5 or higher 

Memory: At least 512MB (2GB or more is recommended) 

Others 

Necessary peripheral devices Monitor (full-color recommended) / mouse or 

tablet 

What is Java? ── You do not have to know it. 

In the operating environment section above, it states, “Java ….”  PICMO is an 
application that operates on Java. Many people may not know or understand Java, 
but do not worry. For Macintosh users, Java has been installed on your PC, already. 
For Windows users, Java will be installed with PICMO.  
It is okay to remember about Java as just some knowledge, but it is okay if you 
forget about it, too.  
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LESSON １：Basic Operations  

This section explains some basic operations for all functions. Please read to 
understand the broad terms and get the feel of the operation.  

 

Table of Contents 

 

l Start-Up 

l Explanation of Screen 

l Save, Undo and Redo   

l Select Tools 

l Select Object  

l Zoom In/Out  

l Scroll Screens  

l Panel Control 

l Create and Save Files  
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Start-Up 

Windows 
Double-click the PICMO icon on the desktop. 

    

（Actually, it appears as PICMO Paint / PICMO Animation/ PICMO Pro） 
 
 Or, go to “Start” menu and click on “All Programs” → ”PICMO” → ”PICMO” 

Macintosh 
 Double click on PICMO application icon in the “PICMO” folder under 
“Applications”.  

 

About the Screen 

Document 
In PICMO, a “Document” means a single drawing.  It may sound a little strange to 
call a drawing a “Document”, but in the world of software, normally, a program is 
referred to as an “Application” and a product created with the application is referred 
to as a “document”.   
 
When you start PICMO, you should see the screen as shown below. The screen 
shows the state that the application, PICMO, has started and opened a new 
document.  
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This is an example on Macintosh, and it would look very similar on Windows.  

Canvas 
The center area with grid lines, called “Canvas”, is the place to draw pictures.  You 
can draw in the surrounding grey area, too, but it is considered to be protrusion and 
cut off when the document is printed.   

Clear grid lines 
When the canvas is not white but has grid lines, it means that the canvas is clear.  
PICMO offers clear (see through) in addition to white, too.  

Tools on the left side of the screen 
The buttons lined up on the left side are “tools” for drawing.  
Choose a pencil or eraser and scratch the canvas with it; you can work on your 
drawing to a certain extent.  

Palette on the right side of the screen 
The circle (○) with a dot(・) inside is the “brush palette”, where you select the 
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thickness of the line.  
The solid circle (●) under the brush palette is the “color palette”, where you select 
the color. You can see that you can draw with a 5px (pixel) black line under the 
standard setting.   
 
There are more. Small solid circles under the color palette are the colors you used 
recently. As you use many colors to draw, those small color circles increase. The 
rectangle trimmed with red lines on the right corner on near the bottom is an 
iconized “thumbnail” of the current document. The number of thumbnails increases 
as you open more files.  
 

Save, Undo and Redo 

You will be drawing and making animations from now on and you should, at least, 
remember how to save, undo and redo.  These come in handy when you make 
mistakes.  

Save 
No matter what kind of computer you use, it may freeze and lose the current file you 
are working on. We recommend you to save frequently to prepare for such incident.  
 

① Select “Save” from the “File” menu. Or, press Ctrl + S on your keyboard 
(for Mac, Command + S ). When you save for the first time, file dialogue will 
come up and you need to decide and type in the file name.  

Undo 
We can cancel the last action (as if it never happened) using “Undo” function. It is 
convenient when you make a mistake while you are working on the document.  

① Select “Undo” from “Edit” menu, or click on the “Undo” tool, .  You 

may also press Ctrl + Z （  Command + Z  for Mac）on the keyboard to undo.   

Redo  
You can undo the undo. This action is called “Redo”. 
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①Select “Redo” from “Edit” menu, or press Shift + Ctrl + Z （ Shift + 
Command + Z  for Mac）. 
 

Select Tools  

Select a tool 

  
You can select a tool by clicking on the tool. You can also select a tool by pressing a 
key assigned to the tool on the keyboard.  All tools are assigned to certain keys.  
When you move the cursor over the tool, it shows the name and the key assigned to 
the tool.  

  
For example, a key, “D”, is assigned to Pen Tool.  

Multi Tools 

Some tool buttons represent multiple hidden tools. 

  
As for “Shape Tool”, ”Line Tool”, “Four-Sided Figure Tool” and “Circle Tool” that are 
hidden.  
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Select Objects 

Select an object  

The tool on the top of the left side,  , is called “Select Tool”. Select the tool and 
click on the item (called object) on the canvas to select the object. You can move, 
expand or scale-down the selected object.   

Various methods to select an object 

l Select items in a frame altogether 

After selecting “Select Tool”, click on a canvas where no object is present. Drag 
the mouse to expand the frame (without releasing). When you release the click 
button, all the objects in the frame are selected.   

l Select multiple objects individually 

Click on an object with the “Select Tool” and click the next one as you press a 
shift key to select multiple objects one by one.   

l Select a part of the object  

 Click and hold  until multiple tools appears and select  . This is 
one of the select tools, called “Lasso Select Tool”. It allows you to select only 
the part that the mouse enclosed. You can see the difference from the Select 
Tool when you drag it on the canvas.  

Canceling the selection 

Click an area on canvas where nothing is present to cancel the current selection. 
Also, if you click on the selected object while you press a shift key, you can cancel 
the selection of the object only.  
 

Zoom In/Out and Scroll  

You can change the view of canvas larger or smaller and scroll the canvas to make 
your drawing activity easy. It only affects the view and has no effect on the object.  
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Zoom in the screen display  

① Click on “Zoom & Drag” tool, . 

② If you click and hold the mouse button, the canvas enlarges continuously. 
When you click the mouse on the screen, the screen zooms out in stages.  

③ Press “ = ” on the keyboard to zoom in in stages.   

Zoom out the screen display 

① Click on “Zoom & Drag” tool, . 

②（For Windows）As you press a control key, click and hold the mouse button 
on the screen. （For Macintosh）As you press a command key, click and 
hold the mouse button on the screen.   The canvas will zoom out 
continuously without stages. If you click the mouse with the same 
combination, the screen zooms out in stages.  

③ Press “—” on the keyboard to zoom out in stages. 

Scroll the screen display 

① Click on “Zoom & Drag” tool, . 

② Drag the canvas on the screen. 

Cancel zoom in/out and scroll to restore the display back to the way it was. 

① Double click on the “Zoom & Drag” tool icon.  

Panel Control  

Display the panel 

Change the brush size and color using the palette on the upper right corner.  
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Brush Palette  Color Palette 

When you click on the palette shown above, the pen or the shape changes its 
thickness/color accordingly.  
To adjust thickness/color in fine detail, click on these palettes or select “Brush 
Panel” or “Color Panel” from “Window” menu to open the control panel.  

Close the panel 

l If opened from “Window” menu … 

click on the “×” on the upper left corner of the panel. 

l If opened by clicking the palette … 

If you click on the canvas on the screen or select a tool after the panel opens, 
the palette automatically closes. If you do not want to let the palette closed 
automatically, open the palette before scroll.    

 

Create and Save Files 

Create a new file 

① Select “New” from “File” menu. 
② A new file is created and a canvas shown below appears.  
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When two or more files are open, thumbnails of the files are displayed on the right 
bottom of the screen. Click the thumbnail to select the document you want to work 
on swiftly.      

Save files 

① Select “Save” from “File” menu.  
② If the file does not have a name, “Save as” dialogue opens for you to specify 

the file name and the location to save.   

   

③ Select “File > Save as” to save under a different name. 
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LESSON２：Draw Pictures 

Drawing and coloring a picture are the basics of drawing. This section explains how 
to do those operations with PICMO.  

 

Table of Contents 

 

l Draw Lines and Shapes 

l Change Thickness of The Line 

l Control The Brush Panel 

l Coloring 

l Change of Color 

l Control the Color Panel 

l Gradation 

l Good Boy! Pen and Shape-Memory Drag Pen 
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Draw Lines and Shapes 

Draw Lines 

Select  (Pen tool) from the tools on the left side, then click & drag to draw free 
lines.  

Draw Shapes 

Select  (Line tool) located right under the Pen tool, then click and drag to draw 
straight lines.  

 

 

Select the tool 
 

Draw on the canvas 

 
The Line tool button is hiding multiple tools. If you click and hold,    

 
the hidden tools come out as shown above.  
Select one of then and click and drag on the canvas to draw four sided figures or 
circles. 
Press and hold shift key as you drag to draw shape, you can draw perfect circles or 
squares.  



LESSON２：Draw	
 Pictures	
 

	
 

 

22 
 

Change The Thickness of a Line  

Follow the instruction below to specify the thickness of a line. 

Change before you draw a line 

To select the thickness of a line that you are about to draw, click on  
“ Brush Palette” on the right side. Then…  

 
“Brush Panel” shown above appears. If you cannot find the thickness you want, use 
the slider on the bottom of the panel to adjust the thickness. The unit of thickness is 
in px (pixel).  

Change the thickness of the existing line 

When you select a line on the canvas with the select tool,  

 
the “Brush Palette” displays the thickness of the line. If you try to change the 
thickness of the line as explained above, while keeping everything else as it is, you 
can change the thickness of the line on the canvas. 
Please refer to “REFERENCE GUIDE: Brush Palette and Brush Panel” for detailed 
instruction of brush panel.  

 

Coloring 

Coloring Tool 
The icon of a bucket with paint pouring out of it 
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is a coloring tool. Click the canvas with the coloring tool to paint the closed area. 
PICMO recognizes the rim (frame) of the canvas as a boundary line.  

 

 
 
 
→ 

 
Click the canvas with the coloring tool 

(bucket tool) 

 Closed area is filled with the color  

 

Change of Color 

Color palette 
The tool on the right side of the canvas,  

 

 is called “Color palette” and indicates current color. When you draw with the pen 
tool or shape tool, or color with the “coloring tool (bucket tool)” the color shown in 
the Color palette is used. 

Color panel 
To change the current color, click on the “Color palette” to display the     

  
“Color panel”, shown above. You can select the color in the panel.  
The colors with a dot “・” is the one currently used on the canvas.  
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Let’s move the slider next to the letter “RGB”. Do you see that the part with the 
same color on the canvas is changing, too?  This linked color operation, called 
“Dynamic Color Change”, is PICMO’s original function.  
Tactful use of color panel let you make new colors or change the existing color. For 
details, please see “Reference Guide: Tool and Panel > Color Palette and Color 
Panel”.  

Recently used colors  
The colored circles under the color palette 

 

display “recently used colors”.  Every time you select and use a color, the color is 
added here. 

Spuit tool 

Select the spuit tool    and click at any place on the canvas to change the color 
of the color palette.  Also, if you press the command key when the bucket tool 
(coloring tool) is in use, it becomes the spuit tool temporarily.  

Make a new color 
When you click on the last blank space in the color pane, a new color is added. The 
new additional color can be adjusted its thickness with RGB/HSV slider.  
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Gradation 

Gradation (Gradient) tool 

 The tool on the left, called “Gradation tool”, is used to make a gradation. The 
gradation tool may be hidden. If so, press and hold the bucket tool (coloring tool), 

 shown on the left. When the gradation tool appears, click to select the tool. 

Make gradation 
While gradation tool is selected, choose the color(s). Then, click on the area on the 
canvas and drag as it is.  
 

 
 
 It creates gradation with the existing color of the spot and the color of your choice.   

Gradation panel  
While you are using gradation tool, you see the following panel on the bottom of the 
screen  

. 
This is a “Gradation panel” that is used to specify gradation setting.  It has icons 
for (from left to right) straight-line gradation, circular gradation, warp gradation 
and a slider to move center position. For detail, please see “Reference > Tools and 
Palettes > Coloring tool, Gradation Tool”. 
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Good Boy! Pen and Stretch (Drag) Pen 

Good Boy! Pen 
Most of us cannot draw smooth lines with the mouse. Naturally lines become wobbly. 
It would be ideal if the computer can help us in such case. Therefore, PICMO offers 
“Good Boy! Pen”, which fixes the line by stroking it.   
 

Select the “Good Boy! Pen”  from Tools. Then, stroke the line you want to fix 
with the tool. If you stroke small, it smoothens the specific small area while if you 
stroke big, a wide area is smoothed.   
 
※It is a good idea to start stroking on the line that you want to make smooth. 

Shape-Memory Drag Pen 
Press the mouse on the line while Good Boy! Pen is in use.  

Then, the cursor changes to .  Drag the mouse as it is. You can pick up and 

drag the line, can’t you?  
 
This is PICMO’s original pen, called “Shape-Memory Drag Pen”. Literally, it drags 
line to fix as it retains the original shape. Shape-Memory Drag Pen can pick up at 
any part of the line.  

Combination of Good Boy! Pen and Shape-Memory Drag Pen 
When you fix a line, you drag the part of the line you want to move big with the 
Drag Pen as you stroke the line with Good Boy! Pen. You will realize greatness of 
PICMO, once you master the skill.   
 
Also, you can connect lines by picking up the end of the line with the Drag Pen, put 
it over the other end and stroke the connected area with Good Boy! Pen. 
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LESSON ３：Creating Animation 
※This function is available for PICMO Animation, PICMO Pro only. 

Easy Animation, “AnimClip” 
Here, we explain how to make animations with PICMO’s most significant feature,  
“AnimClip”. 
 

Table of Contents 

 

l Creating AnimClip 

l AnimClip：Peg Mode 

l AnimClip：Baton Mode 

l AnimClip：Sound 

l Metronome 

l AnimClip Options 
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Animation made with AnimClip 
※This function is available for PICMO Animation and PICMO Pro only. 

PICMO uses “AnimClip” to make animations.  
AnimClip is a patented technology that was developed to make it possible for 
anybody to create animations easily. This technology is not included in any software 
other than PICMO.  
The following is the process of AnimClip making.  

First step 
 Following is the procedure of changing a drawing on the canvas to an AnimClip 
and move it:  
 

① Select an object on canvas 
You can select what you drew or a downloaded photo.  

② Select “Create AnimClip” from “Animation” menu  
When you see a dialogue like the following one, select Peg mode or Baton 

mode and type in the name you want to use.  

 
 
Peg Mode is a mode that allows you to place pins on the character, drag with the 
mouse one by one and record them one after the other.  
On the other hand, Baton Mode is a mode that allows you to move the pins to create 
poses, drag with the mouse and record the movement between poses.  
 
It may be a good idea to start with Peg mode.  Press “OK” after setting. 
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When you create AnimClip, the selected object is framed with a red line and the 
control panel appears underneath. The panel is called, “AnimClip Panel”.  The 
AnimClip Panel can be moved to anywhere you like.  
 

 
 
 
※	
 AnimClip is a function available for PICMO Animation, Pro only.  You cannot 

use it with PICMO Paint.   
※	
 Baton mode is a function available for PICMO Pro only.  You cannot use it with 

PICMO Paint or Animation.   
 

AnimClip: Peg Mode 
※This function is available for PICMO Animation and PICMO Pro only. 

AnimClip Panel on Peg Mode 
When you create an AnimClip on Peg mode, following “AnimClip Panel” appears.  

 
When you operate AnimClip Panel, you can record transforming animation, moving 
animation and sound animation.  

Create Peg animation 
Let’s try to make transforming animation that is the most significant feature of 
PICMO. On Peg mode, it allows you to pin and move the object as it records the 
movement to make an AnimClip. If you want to move multiple places, you keep 
recording new moves over the previous one.  The procedure is explained below.  



LESSON３：Making	
 Animation	
 

	
 

 

31 
 

 

① Select “Peg” AnimClip, , from AnimClip Panel 
② Place a pin on the key position for a transformation. 

(Click on the pin to delete it.) 
③ Drag the pin to test the movement. 

(The animation is not recorded at this point.) 

④  Press “Record”, then drag the pin to record the movement. 

⑤  Press “Play” to check the recording. 
⑥ If you do not like the movement, do it again from ② or ④.  
⑦ Recording the other pin movement over the previous recording.  

 
If you desire to reset the transformation and bring back to the original shape, press 

“Reset” button, .  

Recording starts from the beginning only. If you cannot press the “record” button, 

press  on the top right to rewind.  

Create a moving (position changing) animation 
Next, let’s try creating an animation in which the character moves place to place on 
the canvas.  
This type of animation is called “motion anime”.  

① Select “Motion”  from AnimClip Panel. 
② Click inside of the red AnimClip frame and drag it to the place where you 

want to move the character first.  

③  Press “Record”, then drag the character. 

④  Press “Play” to check the animation.  
 
If you do not like the movement, you can start all over again as many times as you 
want. (The movement is recorded over the previous recording.)  
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Edit tracks 
You can edit tracks after recording. The procedure is as follows: 

After recording, select “Edit tracks” on the far right of the AnimClip Panel.  

The track is displayed as a red line, and the cursor becomes a Good Boy! 
Pen. 
⑤ Fix the red track with the Good Boy! Pen or Drag Pen.  

 

Create sound animations 
Please see “LESSON 4: Add Sound to Animation” for the instruction on sound 
animation.  
 

AnimClip: Baton Mode 
※This function is available for PICMO Pro only.  

On AnimClip Baton mode, place a pin on an AnimClip, move the pin to the next 
pose and connect each pose smoothly to make an animation.  It requires a higher 
technique than Peg Mode and capable of creating movements that seem more 
natural.  
 
Since you move the mouse as if you move a baton, it was named as “Baton Mode”. 
Baton mode is available only with PICMO Pro.    

AnimClip Panel on Baton Mode 
When you create an AnimClip and select Baton Mode, a following AnimClip Panel 
for Baton Mode appears. 
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Create Baton Animation 
The procedure for creating transforming animation with Baton Mode is as follows.  
 

① Create an AnimClip and select Baton Mode. 

② Select “Baton Mode”  from AnimClip Panel. 
A Baton Panel, as shown below, appears.  

 
③ Place a pin at a spot that seems to be a key position in AnimClip for 

transformation.  
（To remove a pin, click on the pin that you want to remove.) 
④ Drag the pin placed in ③ to create the first pose.  
⑤ Click the “+” in AnimClip Panel to register the first pose.  

Baton Panel displays  “pose knot” as a mark of registered pose. 

 
⑥ Drag the pin and create the next pose.  
⑦ Click the “+” in AnimClip Panel to register the next pose.  

You can move it from place to place by selecting and dragging the pose 
knot.  
When you remove a pose, select the pose knot and click “—” on AnimClip 
Panel. 
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⑧ Repeat ⑥〜⑦ to register poses as many as you need. 
The figure below shows that three poses are registered.  

 

⑨ When you drag  “Baton Ball” on the Baton Panel as you like, you can 

see that the object transforms smoothly between the pauses that AnimClip 
registered.  

⑩ Press  “Record”, then drag the Baton ball to record the movement. 

⑪ Press  “Play” to check the movement.  

Create moving (position changing) animation 
The method of moving (position changing) animation is as same as Peg Mode. 
Please see the previous section, “Create Animation / Peg Mode / Create moving 
animation”.     

Edit tracks 
You can edit tracks after recording an AnimClip. The method is the same as Peg 
Mode, but the tracks appear in the Baton Panel instead of AnimClip frame. Please 
refer to “Creating Animation / Peg Mode / Edit tracks” for the detailed instruction.  

Create sound animations 
Please see “LESSON 4: Add Sound to Animation” for the instruction on sound 
animation.  
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AnimClip: Metronome 
※This function is available for PICMO Animation and PICMO Pro only.   

Timing your recording with a metronome  
When you click on a triangle located on the very left side of the AnimClip Panel, the 
triangle points down and an additional panel appears underneath.  

 
The lower panel is used to control the “Metronome” function.  
Especially, when you are recording some pin movements over and over in layers, 
you want to set the timings right. For instance, it is useful when you record the 
movement of walking left leg over the recorded movement of the right leg.  
PICMO offers metronome function for this kind of recording. The timing of each 
movement matches perfectly if you record your animation as you listening to the 
sound of metronome.  
 

l  Metronome ON/OFF 

It turns ON or OFF the metronome sound. When it is ON, you hear the count 
of two measures, “One. Two. One, two, three, four”, before the recording 
starts.  

l Tempo 

 
 It sets the tempo of the metronome.  

 
When you start recording with the metronome turned OFF (default setting), the 
recording starts when you start dragging the mouse. However, when the metronome 
is ON, recording starts automatically after the two-measure counting. 
 

AnimClip: Sound 
※This function is available for PICMO Pro only.  

Add sound to AnimClip 
You can assign sound to AnimClip. 
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Please see the next chapter, “Add Sound” for detailed instructions.   
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LESSON４：Add Sound to Animation 
※This function is available for PICMO Animation and PICMO Pro only.  

PICMO can handle sound, too.  
PICMO Animation can add BGM to the entire animation.  
PICMO Pro can assign sound to each AnimClip in addition.  
Because this is PICMO, of course, the operation is very easy.  

  

Table of Contents 

 

l Import sound files 

l AnimClip Sound 

l BGM Sound 
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Import Sound Files 
※This function is available for PICMO Animation and PICMO Pro only.  

Using external file 
PICMO imports external sound files and use them for BGM or sound effects.   
There are 3 ways to import sound files.  
 

l Drag an external sound file to the canvas of PIMCO and drop it on the canvas.  

l Select a sound file from “File/ Import” menu. 

l Select “File/ Crip Art” menu, then select a sound file.  

It may be a good idea to use the Crip Art in the beginning.  
Material 

BGM Sound 
※This function is available for PICMO Animation and PICMO Pro only.  

Assign BGM to an animation 
Sound file can be assigned to an animation itself and used as a BGM for the 
animation throughout.   
 

When you import a sound file as instructed in the previous page, a “Sound 
Properties” panel (shown below) opens. Select “As BGM”.  
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⑫ Find “Recording Panel” on the canvas.  

 
When you click on the musical note sign, it plays the sound.  

 
In case of BGM, it automatically plays the sound for the entire document as it is 
(just as it was imported), so that any additional work, such as recording, is not 
necessary. Use the timeline to control BGM repetition.  
 

AnimClip Sound 
※This function is available for PICMO Pro only. 

Assign sound to an AnimClip 
You can assign sound to an AnimClip. The sound can be played at the timing of your 
choice.   
 

① Create an AnimClip and make animation with Peg Mode or Baton Mode. 
② Import sounds as instructed in the previous page. 
When the “Sound Properties” panel opens, set the sound linkage to the 
AnimClip that you are working on. (In the example shown below, the sound is 
linked to AnimClip 1.)  
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③ Find “Recording Panel” on the canvas.  

 
When you click on the musical note sign, it plays the sound.  

④ Press  on the AnimClip Panel to activate Sound Mode.   

⑤ Press  “Record”. 
AnimClip Panel changes to the recording sign, shown below, 

 
and it starts playing the recording of Peg or Baton. Click on “♪” on the 
Recording Panel to play the sound with good timing as you watch the video.  

 
⑥ To stop recording, click anywhere on the canvas except the Recording 

Panel.  

⑦ Press  ”Play” and check the recording.  
 
※	
 PICMO automatically extends the recording to match with the longest 

animation or sound recorded. To adjust recording exactly the way you want, you 
need to use “Timeline”. Please refer to “LESSON 6: Use of Timeline” for a 
detailed instruction. 
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LESSON５：Working with Layers 

This lesson offers the instruction of how to use “Layers”, which is useful to draw 
pictures and create animation.   
 

Table of Contents 

 

l Understand Layers 

l Layering Operation Basics  

l Object Control on the Layer 

l Setting Layers  
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Understand layers 

What is layer?  
Layer is a sheet or thickness of material covering a surface. For example, a drawing 
that looks like it is drawn on a sheet of paper can be worked separately on multiple 
layers, such as background, character A and character B.   
 
Each layer may have clear area that has nothing on, and the lower layer can be seen 
through it. It is as if pictures are drawn on clear glass sheets and stacked together.  
 
The biggest advantage of using layers is that a work on a layer does not affect the 
other layers. Also, it is easy to exchange layers. One of the benefits of layering in 
animation is that no opening space appears when the character moves, since the 
background, hidden by the character, is drawn fully on the lower layer.  
 

 
 

１枚の絵に見えても...       It looks like a single picture, but.... 

実はレイヤーが重なっている	
   it is actually a stack of layers.  

レイヤー１ Layer 1    レイヤー２ Layer 2    レイヤー３ Layer 3 

背景  Background 
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Layering Basics 

Create a new layer 
When a new document is created, a layer, called “Layer 1”, is created in Document. 
If you want to use more layers, you need to make new layers.    
 

① Select “Add layers” from “Document” menu or click on “Add layers” button 
on the very left of the Layer bar.  

② The dialogue “Add layers” opens. Type in the name of the layer and click 
“OK”. 

   

Now, a new layer is made right on top of the current layer.  

Check the Status of Layers  
You can check the status of layers on the “Layer bar” at upper left corner of the 
screen. Layer buttons are lined up on the Layer bar, and you can see the layer name 
and order. The one on the very left is the top layer and the one on the very right is 
the bottom one.   
 
The layer currently selected (layer that being drawn) is indicated in blue.  
To switch the current layer, simply click on the name of the layer that you want to 
work on. 

  

Layer button location when Timeline is being used 
When Timeline is activated, layer buttons line up vertically in the window.  
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Change the order of layers in the stack 
To change the order of layers in the stack, drag and group the layers you want to 
change. 
When you press the mouse on the layer that you want to move, the cursor changes 

to . 

 
Then, drag it to the destination as you keep pressing the mouse.... 
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③ and drop it to move the layer on the right side of (or under) the highlighted 

layer.  

   

Delete a layer 
① Select the layer you want to remove, and select “Delete current layer” from  

“Document” menu or click on “Delete layer” button on the Layer bar on 

the left.  
②  Click “OK” when a dialogue box that asks for your confirmation to delete 

appears.  
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①  

Control of Object on the Layer 

Find out which layer the object is located 
When you draw many objects, you may sometimes forget the location of the object in 
the layers. In such case, please do the following. 
 
 
 
When you press and hold the mouse button on the layer name on layer button, the 
layers except the current layer become semi-transparent and the current layer 
stands out. In the example below, the layer button of the red square is pressed.  

   

Or, when you click on the eye icon on Layer menu (upper left on the screen), you can 
switch to display all→ display other layers semi-transparently→display this layer 
only.   

 

Move an object to a different layer  
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Do the following to move an object to a different layer.  
① Click on Layer button to select the layer and select the object using 

“selection” tool. In this example, a red square is selected in “Red Rect” 

layer.   

② Press Command(Ctrl)＋X keys to cut the object.  

   

③ Click a layer button to select the destination layer of the object. “Yellow 
Rect” layer is selected here.  
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④ Press Command(Ctrl)＋V keys to paste the object. The object has been 
moved to the destination layer. If there is an existing object on the layer, 
the moved object is pasted over the existing object.                                            

   

 

Set Layer Properties 

Layer Properties 
Layers can be used under various settings.  
“Layer Properties” dialogue box appears when you double click a Layer button, or 
select “Layer Properties” from “Document” menu or press “Layer Properties” button 
on Layer bar. 



LESSON	
 5	
 	
 Working	
 with	
 Layers	
 

	
 

 

49 
 

  

l Name 

Input a new name here to change the name of the layer. 

l Alpha (Opacity) 

You can set the opacity of the objection the layer by using the slider. “1.0” is 
completely opaque, and “0” is completely transparent. You must click “OK” to 
reflect your choice of opacity.  

l Hide  

Check here to hide the layer temporarily  

l Lock 

Check here to prevent editing the layer any further. It is used to protect the 
objects on the layer.  

l As Draft 

Check here to set the layer to Draft mode. When you select the other layer, the 
layers with a check in “As draft” box are displayed semi transparently. Draft 
layers cannot be exported or printed.  

Layer setting on the layer button 
You can set the layer to “Hide”, “Lock” and “Draft mode” by clicking the icons on the 
layer button.  

	
  
  You can set each, “Hide”, “Lock” and “Draft mode” (from left to right) separately.  

Control layers with icons on Layer bar 
You can also control layers with icons on the Layer bar.  
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 Add Layer 

Adds a new layer.  

 Delete Current Layer  

Deletes the layer that is currently selected.  

 Change Layer View 

Switches the Layer View to “Display layers semi transparently except the 
current layer”, “Display current layer only” or “ Display all layers” with each 
click.  

 Layer Properties 

“Layer Properties” dialogue appears.  



LESSON	
 6	
 ：Use	
 of	
 Timeline	
 

	
 

 

51 
 

LESSON６：Use of Timeline 
※This function is available for PICMO Pro only. 

PICMO Pro has “Timeline” to create more advanced animations. With Timeline, you 
can do time management and make special setting, like “repeat”, on animations.   
 

Table of Contents 

 

l Understand Timeline 

l Animation in Frame Units  

l AnimClip on Timeline 

l Create Tween Animation 
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Understand Timeline 
※This function is available for PICMO Pro only.  

Display Timeline 
Timeline appears when you click on the right pointing triangle located at upper left 
corner of the screen or press Command(Ctrl)＋T keys.   

  
Timeline is opened. 

  

What is Timeline? 
Timeline literary controls transition of the animation by the progress of time. With 
PICMO, you can create animations without worrying about Timeline. So, if you feel 
that “I do not understand this at all!”, you do not have to use Timeline.  
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Let’s try and click on  next to Layer1 and take a look at the content.  

  

	
 Frame 

The rectangles lined up over the Timeline are called “frame”. It is equivalent 
to a sheet (page) of flipbook. In early stage, there is only one frame.    

	
 Play head 

The red vertical line, called “Play Head” indicates the frame that is currently 
displayed. It moves toward right as the animation plays. You can move it in 
the frame by dragging the thick red part or clicking the area.  

	
 Blank Key-frame 

There is a white ○  in the draw frame. This frame is called “Blank 
Key-frame”.  This is a Key-frame that has nothing drawn on it, yet.  

	
 Key-frame 

When there is an object on the canvas, it changes to a black ●. It indicates 
that the picture in this frame, called “Key-frame”, changes in the frame.   

	
 Frame information 

On the left under the timeline, you see “24fps” indicated.  The “fps” is an 
abbreviation of “frames per second”.  24fps means that 24 frames are played 
in 1 second. The number next to the “#” in the middle indicates the location of 
Play Head in the frame. The clock mark on the left indicates many second how 
has passed from the start.  
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Animation by Frames 
※This function is available for PICMO Pro only.  

When you use Timeline, you can create animation in a different way from AnimClip.  
It is similar to a concept of flipbook that you draw pictures one by one and flip them 
to make the picture move.  Other animation software normally offers this kind of 
method only. Therefore, PICMO’s AnimClip is the one that offers unique way to 
create animation.  

Using Key-frame to make a flipbook animation 
Let’s create a simple flipbook animation using Timeline. 
As an example, we will make an animation in which a circle gradually becomes 
larger.  
 

① Create a new document and display Timeline. Click Layer1 to bring up 
“Draw”. Draw a small circle on the canvas. The first frame becomes the 

 “Key-frame”.  

   

② Click  at the bottom left of Timeline to create a “Blank Key-frame”. A 

new  “Blank Key-frame” is added to the second frame, and the play 

head moves to the second frame, also. It is just like adding a new blank 
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sheet. The canvas becomes totally blank since it is showing the second 
frame, now.  

   

 
③ You want to draw a slightly larger circle in the second frame; therefore, 

you wan to display the drawing on the first frame semi-transparently. 

Click an onionskin icon . This is a function that displays other frames 

semi-transparently and useful to create animation as you refer to the 
previous frame. Now, we are going to draw a circle that is slightly larger 
than the one we drew earlier in this setting.  
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④ Repeat the operation above and draw circles that gradually become larger 
in 5 frames or so. Then let’s click on the “Play button” on the bottom right 
of the Timeline to play. 

   

“Draw” on the Timeline 
“Draw” on the Timeline (Not an AnimClip) is a normal object. If there is a Draw on 
the layer, it appears on Timeline. This Draw can be stretched or shrunk on the Time 
like just like other elements.  
 
When you draw “Draw” in Frame1, it becomes a special Draw that appears in the 



LESSON	
 6	
 ：Use	
 of	
 Timeline	
 

	
 

 

57 
 

animation throughout. This is a function that maintains compatibility with PICMO 
Animation, which cannot utilize Timeline.   
 
In the example below, “Background” Draw is shown in Frame 1 only, but when you 
play the animation, it appears for the entire length of animation. On the other hand, 
“Foreground” Draw is drawn in frame 6 through 14and in no other frames. When 
you play the animation, it appears on frame 6 and disappears on frame 14.  

 
For the Draw in Frame 1, which is displayed for the entire animation, a faint green 
tape appears after the second frame.  

Copy/Cut & Paste of Draw Frames 
Draw frames on the Timeline can be copied or cut to paste on the other frames. If 
you click as you press a Shift key, you can select the range, too.   

 
 
 

AnimClip on Timeline 

Using Timeline, you can adjust time related setting, such as the speed of the 
movement and the length of display set for the AnimClip.  

When you record AnimClip … 
When you create AnimClip, and record in Peg Mode, for instance, it appears on 
Timeline as shown in the figure below. 
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There is a light blue block in “AnimClip1” over “Layer 1”. This indicates that 
AnimClip exists on the canvas “from frame 1 through 20”.  
You see a purple line in the light blue block. It indicates that there is a recorded 
AnimClip (Peg) from frame1 through frame 20.   
In other words, a block indicates the “time of display”, and the line indicates 
“movement”.  Please make sure to remember this, since it is essential to 
understand the items that are introduced later in this manual.   
 
Let’s take a look at the example. For instance, we stretch the light blue block and 
purple line to frame 40. 

 
If you play with this setting, the duration of playback becomes longer, and the 
movement repeats as it becomes longer. （The loop around frame indicates 
repeating.)  
Next, let’s click on the purple line, then click “Repeat” button on bottom left of the 
Timeline.  Repeat is cancelled and the line becomes shorter.  

 

When you play the animation, AnimClip1 stops at frame 20, but the animation 
keeps playing up to frame 40. AnimClip1 stays frozen for the last half.  “Duration 
of playback” indicated by the block does not change, but “movement” indicated by 
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the line stopped in the middle of playback.  
 
Next, click on the ● at the right end of purple line, hold and drag it to frame 40.  

 
When you playback, the recorded movement becomes slow and play until frame 40. 
This is a result of stretching the “movement” indicated by the line.  
 
The block indicates “duration of playback” and the line indicates “movement”. These 
are important points, so let’s remember them.   

Color of line depending on the recording method  
PICMO offers various kinds of animations, such as each mode of AnimClip and 
Tween, which is explained in the next section. Timeline displays them separately 
with lines of different colors.    

  

l Blue Line 

Indicates recordings with AnimClip’s motion mode recording 
l Purple Line 

Indicates recordings with AnimClip’s Peg mode 
l Pink Line 

Indicates recordings with AnimClip’s Baton mode 
l Green Line 

Indicates recordings with Tween 
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The color of block that indicates time is light blue for all methods.  
 
When you use both, Motion mode and Peg/Baton mode to record in an AnimClip, 
two lines appear in the same block as shown below.  
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Create Tween Animation 
※This function is available for PICMO Pro only.  

Timeline has “Tween” function, in which the computer automatically complements 
two shapes. Let’s make animation, using this function. 
 

① Draw any shape in frame 1 (a red rectangle is drawn here) and set it as Peg 
mode animation.  Please refer to “LESSON 3: Create Animation > Create 
AnimClip” to make an AnimClip.  

   

 
② Next, draw and specify the shape after transformation. Here, we make 

animation that transforms in two seconds; therefore, click on the 48th 
frame (24 × 2seconds) to move the playback head 。                                                
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③ Click on the T icon, “Add Key-frame for Tween” at the left bottom of the 

Timeline. Frame 1 through frame 48 has been connected with a green line.  
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④ Change the shape in the 48th frame. Click  at bottom left of the 
screen to show “bounding box”, then transform the shape.  

 
When it is done, let’s check it by clicking on the Play button at right bottom 
of the Timeline.  An animation that gradually transforms from the state in 
frame 1 to the one in frame 48 is complete.   
  

Set Easing 
“Easing” is a function that adjusts the tween tempo. When easing is set, you can 
change the tween speed fast or slow. Once you master easing, you can create the 
moving image more realistically.  
 

①	
 If you select the green line on the Timeline, a word, “Tween”, appears on 
the bottom left of the Timeline.  

   

②	
 “Easing Panel” appears on the bottom of the screen. You can set tempo 
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from “-10” (the slowest) to “10” the fastest by moving the slider. Until you 
become used to it, try different setting and see how the movement changes.                      

   
③	
 Once the easing is set, a green triangle appears on the frame.  In the 

figure below, for example, it is slow in the beginning and become faster 
toward frame 48.      
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LESSON 7：Data Import and Export  

PICMO can import external file and use it. Also, it allows you to export drawings 
and animations you created in various format.  
 

Table of Contents 

 

l Supporting Format 

l Import Data 

l Export Data 

l Use of Crip Art  
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Supporting Format 

Importing 
PICMO can import and use files in the following formats: 

l PICMO Paint/Animation/Pro 

JPEG image 
GIF image 
PNG image 
SVG image (partial) 

l PICMO Animation/Pro 

WAV sound 
AIFF sound 

Exporting 
PICMO can export data in the following formats: 

l PICMO Paint/Animation/Pro 

JPEG image 
PNG image 

l PICMO Animation/Pro 

QuickTime movie 

l PICMO Pro  

Flash SWF movie 
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Data Importデータの読み込み  

PICMO can import photos, image data created with different software and sound 
data to use for animation.  

Importing procedure 
① Select “Import...” from “File” menu. 
② When the file dialogue appears, specify the image or sound file you want to 

import.  
③ An appropriate dialogue for the specified file appears. Choose your setting 

and click “OK”.   
 

Import Image 

Import svg files 
You can import svg files that are created with PICMO only.  

Import bitmap image files 
You can import bitmap images of jpeg, gif and png.  
When you began to import a bitmap image file, following dialogue appears, and you 
can clip with background etc.  
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If you want to strip background, click on the color of the area you want to strip in 
the original image. Please refer to “Reference Guide > Menu > File Menu > Import” 
for detailed instruction.  

Import Sound 

Import sound 
You can import external sound file and use it for your animation. Please refer to 
“Lesson > Add Sound” for details.  
 

Data Export 

PICMO can export data in various file formats. There is a restriction on a part of 
exporting operation with trial version.  

Exporting procedure 
① Select “Export → (Exporting file format) ” from “File” menu. 
② When the file dialogue appears, specify the place and file name to save.  
③ An appropriate dialogue for the specified file appears. Choose your setting 

and click “OK”.   
 

Image Export 

PICMO can export the document that is being drawn as PNG or JPEG (still) image. 
When you select “File > Export > PNG export” or “File > Export > JPEG image”, an 
appropriate dialogue for each format appears.  Please specify your setting and save 
it in the file. For the detail of the dialogue, please refer to “Reference guide > Menu 
> File Menu > Export”. 
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        PNG Export Dialogue                  JPEG Image Export Dialogue 

Movie Export 

Flash SWF Export 
※This function is available for PICMO Pro only.  

It exports the file, which is 
currently open in Flash SWF format. 
This function is restricted for trial 
version.  
If you select Flash SWF Export 
from Menu, a dialogue similar to 
the one shown right appears, and 
you can save the file. For detailed 
explanation of the dialogue, please refer to “Reference Guide > Menu > File Menu > 
Export > Flash SWF Export”. 

QuickTime Export            
※This function is available for PICMO Animation / Pro only. 

It exports the file, which is 
currently open in QuickTime format. 
This function is restricted for trial 
version.  
If you select QuickTime Export 
from Menu, a dialogue similar to 
the one shown right appears, and 
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you can save the file. For detailed explanation of the dialogue, please refer to 
“Reference Guide > Menu > File Menu > Export > QuickTime Export”. 

  

In addition, you need to download and install the latest QuickTime to export 
QuickTime file using Windows.（If you use Macintosh, it is not necessary since 
QuickTime is included in the first place.) 
 
You can visit the official QuickTime page of Apple Inc. using the following 
URL: 
 http://www.apple.com/jp/quicktime/download/ 

Use of Crip Art 

Upon your purchase of PICMO Animation/Pro, image files and sound files of more 
than 100M Byte come with it. These are high quality images made for PICMO users 
and you may use them in anyway you want.  

How to import from Crip Art 
You may use Crip Art with the following procedure  

①	
 Select “Crip Art” from “File” menu.  
② File Dialogue appears. Select the file you want from “ClipArt” folder in the 

dialogue and import.   
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LESSON 8：YouTube Upload 
※This function is available for PICMO Animation and PICMO Pro only. 

You can upload (post) the animation you made with PICMO on YouTube easily. If 
you have YouTube account, you can post on your account channel, or you can post it 
to PICMO’s common account and exchange your animation with the members all 
over the world.  

  

Table of Contents 

 

l Prepare to post on YouTube 

l Post on YouTube 
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Prepare to Post on YouTube 
※This function is available for PICMO Animation / Pro only.  

Setting an account （Channel setting） 
Before you upload on YouTube, go to “PICMO (‘Edit’ for Windows) > Preferences 
>YouTube” and set up your YouTube account for posting”.  

 
In this dialogue, you can specify the account you want to use, either PICMO’s 
YouTube common account or your own account.  For detail, please refer to 
‘Reference Guide > Preferences > YouTube”.  

 
Following is the upload destination for common account: 
PICMO Box	
 http://www.youtube.com/PicmoBox 
 

Post on YouTube 
※This function is available for PICMO Animation and PICMO Pro only.  

 

Select “YouTube upload” from File menu to post an animation on YouTube. Then, 
following dialogue appears. Please input necessary information.  
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YouTube Uploader 

 

l Title (of animation) 

An animation that you upload on YouTube starts with the title screen. Please 
type the title of the animation you wish to upload.   

l Author 

Input your name here. It will be shown as “by ○○” in the title screen.  

l Comment 

Type your explanation of the animation. It appears on the comment frame on 
YouTube. 

l Keyword (for search) 

Type keywords that make it easy for other users search. (Tag)  

l Upload account 

It indicates an account used to upload. If you want to change the account, 
open “PICMO (‘Edit’ for Windows) > Preferences >YouTube Tab”. 

l Upload 

At last, click this button to start uploading.   

Actual uploading 
When you click “Upload” in YouTube Uploader, PICMO uploads the animation on 
YouTube after it optimizes the animation.   
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Once upload is complete, it shows the URL of the animation. Please click on the 
URL to open YouTube. URL differs for each animation. Since it takes for a while to 
encode on YouTube side, it will not come up immediately. However, you can confirm 
that your animation is posted as one of YouTube animations after a while.  

  
You can copy and send this URL to your family and friends to share your animation. 



	
 

 

 
 
 
 
 
 
 
 
 
 

PICMO MANUAL 
 
 

REFERENCE GUIDE  
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Menu 

“File” Menu 

New 
Creates a new file. 
Shortcut: Win  Ctrl   N    Mac  Command   N  

Open 
Opens an existing file. 
Shortcut: Win  Ctrl   O    Mac  Command   O    

Open Recent 
Shows a list of files opened recently. 
You can set number of files to display at “Preferences > General”.  

Close 
Closes the file that is open currently.  
If it is not saved while there is any change, a warning appears.  
Shortcut: Win  Ctrl   W    Mac  Command   W  

Close All 
Closes the file that is open currently. 
Shortcut: Win  Shift   Ctrl   W    Mac  Shift   Command   W  

Save 
It saves the file that is open currently.  
If it saves the file for the first time, a dialogue that asks for file name appears.  
Shortcut: Win  Ctrl   S    Mac  Command   S  

Save As 
It gives a new name to the file and creates a brand new file.  
Shortcut:  Win  Shift   Ctrl   S    Mac  Shift   Command   S  
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Import 
It imports external image files and sound files.   
It displays a dialogue to specify import setting after it imports an image file.    

 

l Transparency 

You can specify the transparency of the image. 
l None 

It imports the image as it is without setting its transparency.  
l Use images Alpha 

It uses the transparency specified in gif or png file for the 
transparency of the image. 

l Use Background Color 

It uses a specific color in the image as the background color and set it 
to be transparent. 

l  Background Color  

It displays the selected background color (transparent). When you move the 
mouse over the “original image”, the cursor changes to a spuit. When you click 
a point in the image with it, the color you clicked becomes the background 
color.  

l  Threshold 

It specifies how much color difference can be allowed for a color to be treated 
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as background color, based on the “background color” above. The more 
difference is allowed when the slider is set farther to the right.   

l Types 

It specifies the type of image. Depending on this setting, the way of treating 
image or background changes. 

l Photo 

It handles images as photos. 
l Drawing 

It handles images as drawings. 
l Animation 

It handles images as animations.  

l Smoothness (Displayed only when the Preference Setting, “Use Expert Mode 

for Bitmap Importing” is ON)   

It specifies smoothness of the area, which is recognized as “background 
color”. As the number becomes larger, the resulting background becomes 
vague and smooth so that the borderline between filtered and unfiltered 
does not stand out.  

l Anti Key Color (Displayed only when the Preference Setting, “Use Expert Mode 

for Bitmap Importing” is ON)   

 

When a sound file is imported, it displays Sound Properties to specify the 
import setting.  
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l Sound Name 

Name the sound. When you import, the file name is set. 

l Linkage To 

You set the subject that you want to assign.サウンドを割り当てる対象を設定し
ます 

Export ＞ Flash SWF 
It exports the file currently open in Flash SWF format.  
Wen you select this menu, “Flash SWF Settings” dialogue appears.  

 

l Export source 

You select the export source. 

l Single Image 
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Exports the frame currently selected only in still image swf format.  

l Animation 

Exports the whole animation as a video in swf format.  

l Flash Version 

Selects flash version. 

l Spline Interpolation  

Transforms curvy area to spline. When you spline, the exported data memory 
becomes small, and may change the shape of the curvy line. Effect (Threshold) 

l Effects 

Adjusts the effect of spline. The larger the number, the more effective 
the spline becomes and the smaller the file size while the deformation 
become more significant.   

l Smallest (Apply Size) 

It adjusts the smallest object that can be splined. If you set the 
number to an appropriate amount, you can prevent changing the 
shape of small dot or circle when you the spline effect stronger 

l Show Points 

Previews point in the current frame to confirm the spline effect.  

l JPEG Quality 

Adjusts the quality of positioned bitmap images. The larger number you set, 
the prettier, but the file size becomes large.  When no image is positioned, 
there is no effect even if this is set.   

Export ＞ QuickTime 
Exports the current open file in QuickTime format.   
When you select this menu, “Export QuickTime Movie” dialogue appears.  
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l  Current Dimensions 

It indicates the current document size. You cannot change this item. 

l New Dimensions 

It sets the size, width (W) and height (H), of the image that you are going to 
export.  

l Constrain Proportions 

When you change one of the width or height, it automatically changes the 
other to maintain the ratio of height and width.  

l Codec 

It selects the method of data compression.  

l Quality 

It adjusts the quality of QuickTime image to be exported.  

l Enhance Edge Smoothness 

It smoothens the edge of the object further.  
 
In addition, you need to download and install the latest QuickTime to export 
QuickTime file using Windows.（If you use Macintosh, it is not necessary since 
QuickTime is included in the first place.) 
 
You can visit the official QuickTime page of Apple Inc. using the following 
URL: 
 http://www.apple.com/jp/quicktime/download/ 
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Export ＞PNG Image 
Exports the current open file in PNG format.   
When you select this menu, “Export PNG Image” dialogue appears.  

 

l  Current Dimensions 

It indicates the current document size. You cannot change this item. 

l New Dimensions 

It sets the size, width (W) and height (H), of the image that you are going to 
export.  

l Constrain Proportions 

When you change one of the width or height, it automatically changes the 
other to maintain the ratio of height and width.  

l Single Frame / Multi Frames (Animation) 

You select the frame(s) to export here. It exports the frame that is currently 
shown only. When you select “Multi Frames (Animation)”, the frames in the 
range specified in “From” and “To” boxes in consecutive PNG order.  

l Enhance Edge Smoothness 

It smoothens the edge of the object further.  

Export ＞ JPEG Image 
Exports the current open file in JPEG format.   
When you select this menu, “Export JPEG Image” dialogue appears.  
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l Current Dimensions 

It indicates the current document size. You cannot change this item. 

l New Dimensions 

It sets the size, width (W) and height (H), of the image that you are going to 
export.  

l Constrain Proportions 

When you change one of the width or height, it automatically changes the 
other to maintain the ratio of height and width.  

l Single Frame / Multi Frames (Animation) 

You select the frame(s) to export here. It exports the frame that is currently 
shown only. When you select “Multi Frames (Animation)”, the frames in the 
range specified in “From” and “To” boxes in consecutive PNG order.  

l JPEG Quality 

Adjusts the quality of JPEG image to be exported. The larger the number the 
prettier, but the file size becomes large. When there is no positioning image, 
there is no effect even if this is set. 

l Enhance Edge Smoothness 

It smoothens the edge of the object further.  
 

Crip Art 
Accesses the Crip Art provided by PICMO.  
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You can use images and sounds for free. 

YouTube Upload 
Uploads current open file to You Tube.  
When you select this menu, “YouTube Uploader” appears. 

 

l Title (of animation) 

An animation that you upload on YouTube starts with the title screen. Please 
type the title of the animation you wish to upload.   

l Author 

Input your name here. It will be shown as “by ○○” in the title screen.  

l Comment 

Type your explanation of the animation. It appears on the comment frame on 
YouTube. 

l Keyword (for search) 

Type keywords that make it easy for other users search. (Tag)  

l Upload account 

It indicates an account used to upload. If you want to change the account, 
open “PICMO (‘Edit’ for Windows) > Preferences >YouTube Tab”. 

l Upload 

At last, click here to start uploading. 
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Recent YouTube Upload 
This is a list of animations uploaded on YouTube recently. When you select an 
animation, it jumps to the YouTube page, where the animation was uploaded.  

Print 
Prints what is on the current screen. 

Close PICMO-xxx 
It closes PICMO. If you try to close without saving, it shows a warning 
message.  
You find this menu under “PICMO-xxx” on Macintosh.  
（In the place of “xxx”, one of Paint / Animation / Pro appears.） 
Shortcut: Win  Ctrl   Q    Mac  Command   Q  
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“Edit” Menu 

Undo 
Undoes the last action. 
Shortcut: Win  Ctrl   Z    Mac  Command   Z  

Redo 
Recover the action that was undone.  
Shortcut: Win  Shift   Ctrl   Z    Mac  Shift   Command   Z  

Cut 
Deletes selected object and saves it on the clipboard.  
Shortcut: Win  Ctrl   X    Mac  Command   X  

Copy 
Saves selected object on the clipboard.  
Shortcut: Win  Ctrl   C    Mac  Command   C  

Paste 
Pastes an object saved on the clipboard.  
Shortcut: Win  Ctrl   V    Mac  Command   V  

Delete 
Deletes selected object. 
Shortcut: Win/ Mac  Backspace    Delete  

Select All 
Selects all objects in the current open file.   
Shortcut: Win  Ctrl   A    Mac  Command   A  

Deselect 
Cancels selection. 

Bounding Box 
When a selection tool is being chosen, it displays bounding box.   
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Shortcut: Win Ctrl   B    Mac Command   B  

Find Same 
Chooses all objects that have the same attributes (line thickness and color) 
with the selected object.  

Stroke to area 
Converts a stroke (line) to an area (surface). 

Arrange> Bring to Front 
Arranges the stacking order of AnimClips and moves the selected AnimClip to 
the top. 
Shortcut: Win  Shift   Ctrl   ]    Mac  Shift   Command   ]  

Arrange > Bring Forward    
Arranges the stacking order of AnimClips and moves up the selected 
AnimClip by one. 
Shortcut: Win  Ctrl   ]    Mac  Command   ]  

Arrange > Send Backward 
Arranges the stacking order of AnimClips and moves back the selected 
AnimClip by one.   
Shortcut: Win  Ctrl   [    Mac  Command   [     

Arrange > Send to Back 
Arranges the stacking order of AnimClips and moves the selected AnimClip to 
the bottom. 
Shortcut: Win  Shift   Ctrl   [    Mac  Shift   Command   [  

Preferences 
Specifies various preference settings of PICMO. For detail, please refer to 
“REFERENCE/ Preferences”. 
＊You find this menu under “PICMO-xxx” on Macintosh.  
（In the place of “xxx”, one of Paint / Animation / Pro goes in.） 
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“Document” Menu 

Add Layer 
Adds a layer.  
When you select this menu, a layer is added to the current layer, and a 
dialogue box to set Layer Properties appears. Content of the dialogue is the 
same as “Layer setting” explained later.  

Delete Current Layer 
Deletes the currently selected layer. 

Layer Properties 
Specifies layer properties. 
When you select this menu, a dialogue box to set Layer Properties appears.   

  

l Name 

Assign a name to the layer. レイヤーに名前を付けます。 

l Alpha (Opacity) 

l Specifies the transparency of this layer. All objects on this layer are set to 
this transparency.  “0.0” is completely transparent and “1.0” is completely 
opaque.  

l Hide  

Check here to hide the layer temporarily  

l Lock 

Locks the layer to prevent from being edited.  

l As Draft 
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Set the layer as a draft. A draft layer appears semi transparently when other 
layer is selected and is not printed when printing.  

Load Palette 
Loads color palette.  

l > Default 

Imports PICMO’s default color palette.  

l > Flash 

Imports Flash color palette. 

l Import palette＞ MacOS 

Imports Mac OS color palette.  

l Import palette ＞ Windows 

Imports Windows color palette.  

l Save palette as default 

Sets the current palette as your default palette.  

Remap Colors 
Remaps colors.  
  After importing a color palette, it reselects the same color that you used at 
last from the colors on the new palette and return the same colors to the 
drawing. If the new palette does not have the matching color, the color is 
added to the end.  

Document Setting 
Confirms and changes the setting of the document currently open. 
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l Current Dimensions 

Indicates the current document size in pixels. 

l New Dimensions 

If you input numbers in the boxes here, the document size changes according 
to the value, when you close this dialogue.   

l W 

Input the width of the document. 
l H 

Input the height of the document 

l Constrain Proportions 

When you change one of the dimensions, it automatically changes the 
other to keep the ratio of height and width the same. 

l Scale Contents 

When you change the dimensions of the canvas, you decide if the 
contents are to expand or scale-down, also.  

l Animation Speed 

（PICMO Animation/Pro only） 
Changes the frame counts per second. The larger the frame counts the 
smoother the animation becomes.  AnimClip can play smoothly regardless of 
this setting.  



REFERENCE	
 GUIDE：Menu	
 

 

91 
 

l Preserve Total Duration (Changes frame counts)  

If you check here, it fixes the duration of an entire animation and 
allows you to change frame counts, when the animation speed is 
changed.  On the contrary, if there is no check here, it changes the 
duration of the animation without changing the frame counts.  

l Set as Default 

Set the current document setting as a default setting for a new document. 
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“Animation” Menu 

※This is the Menu for PICMO Animation / Pro only.  

Create AnimClip 
Creates AnimClip from the object that is selected. 
When you select this Menu, it opens AnimClip setting. 
Shortcut: Win  Ctrl   R    Mac  Command   R  

 

Break AnimClip 
Cancels AnimClip on the selected object. 
Shortcut: Win  Shift   Ctrl   R    Mac  Shift   Command   R  

AnimClip Properties 
You can changes the name and Peg / Baton setting of AnimClip here.  
 

Please refer to “REFERENCE / AnimClip” for detailed information regarding 
AnimClip. 
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“Window” Menu 

Toolbox 
Displays toolbox. 

Layer Bar 
Displays Layer Bar.  
Shortcut: Win  Ctrl   L    Mac  Command   L        

Timeline 
Displays Timeline. 

   Shortcut: Win  Ctrl   T    Mac  Command   T        
 

Brush Panel  
Displays Brush Panel. 

Color Panel 

Full Screen 
Displays window in full screen mode. 
Shortcut: Win  Ctrl   F    Mac  Command   F      
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“Help” Menu 

Online Manuals 
Starts up browser and displays PICMO Manual etc. on Web.  

Open PICMO Web 
Starts up browser and displays PICMO’s Webpage.  

Check Update Application  
Sends inquiry for updates.  

Check Notice  
Displays notice news.  

About PICMO 
Displays information about PICMO. 
（Located in PICMO Menu for Macintosh） 
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Tools and Palette 

Tools 

Tool Box 
There are tools lined up on the left side of the window. It is called “Tool Box”.  
You can display or hide Tool Box by clicking “Window > Tool Box” on the menu bar. 

 Select Tool 
Selects object with rectangular frame. Click the object or drag and specify the 
range of rectangle to select.  (All objects in the range are selected.) 
Shortcut: Win/Mac  A  

 Lasso Select Tool 
Selects object freely by a range. To select, click the object or drag and select 
the range of unrestricted shape.  (It cuts and selects as exact shape as you 
specified.) 
Shortcut: Win/Mac  L  

  

Bounding box  
When you select Selection Tool / Lasso Selection Tool, “Bounding Box” 
button appears on the left bottom of the window.  
If you press this button, Bounding Box options appear and you can 
transform the object here.  このボタンを押すと、バウンディングボッ
クスオプションが現れ、オブジェクトの変形が可能になります。 
 

Bounding Box Panel 

 
Input numerical values in this panel to specify the transformation of 
the object in values. From the left, X coordinates, Y coordinates, 
Width, Height, Vertical scale (%), Horizontal scale (%), Rotation 
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degree(°) and Fix Aspect Ratio are on the panel.   
 

Alpha (Opacity)  
When you select AnimClip with Select Tool / Lasso Select Tool, “Alpha 
(Opacity)” button appears on the left bottom of the window.   
If you press the button, Alpha option appears.  
 

Alpha Panel 

 
You can change the alpha (opacity) of the AnimClip by moving the 
slider.  0 is completely transparent and 1.0 is completely opaque. 

Good Boy! Pen   
Select this tool and stroke over the ledge of line or object. The part becomes 
smooth.  
Shortcut: Win/Mac  S  

 Shape Memory Drag Pen 
Select Good Boy! Pen and press the mouse button on the edge of a line or an 
object, the cursor changes to “Drag Pen”. Drag as you press the button to fix it 
in a larger scale.  

  Pen Tool 
Select this tool and drag on the canvas to draw free lines. 
Shortcut: Win/Mac  D  

 Eraser Tool 
Select and drag this tool to erase the object part where the cursor touches. You 
cannot erase external file imported using “Import”.   
Shortcut: Win/Mac E  
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 Line tool 
Select this tool and drag to draw straight lines. 
Shortcut: Win/Mac V  

 Rectangle Tool 
Select this tool and dag to draw rectangular frames.  
Shortcut: Win/Mac  R  

  Filled Rectangle Tool    
Select this tool and drag to draw filled rectangular shape. 
Shortcut: Win/Mac  Shift   R            

 
Round Corner Option 

When you select Rectangle Tool / Filled Rectangle Tool, Round Corner 
Option appears on the left bottom in the window. If you type in a 
value (in pixels), you can draw rectangles with rounded corners. The 
larger the value the rounder the corners become. 

  Circle Tool 
Select this tool and drag to draw circles. 
Shortcut:  Win/Mac  C  

 Filled Circle Tool  
Select this tool and drag to draw filled circles.  
Shortcut: Win/Mac  Shift   C  

 Coloring Tool 
Select this tool and click on an object to change the filled color on the object. It 
does not change the color of lines.  
Shortcut:  Win/Mac  F  
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 Gradation (Gradient) Tool 
Select this tool and drag starting from inside of the object; it gives gradation 
to the fill color on the object.   
Shortcut:  Win/Mac  G    or    Shift   F         

 
Gradation Option 

When you select Gradation Tool, Gradation Option bar appears on the 
left bottom of the window.  You can specify the gradation setting 
here.   

Linear 

Sets gradation type to be linear. 
Radial 

Sets gradation type to be radial.  
Warp 

Sets gradation type to be area shape.  
Midpoint 

Sets the Midpoint of gradation. (Linear and Radial only)  

 Spuit Tool 
Select this tool and click an object on canvas to pick up the color.  
Shortcut:  Win/Mac  I  

 Text Tool  
Inputs letters. Select this tool and click on any spot on canvas to decide the 
starting point of the letter. Then start typing to input letters.  
Shortcut: Win/Mac  T  

 
Text Option 

When you select Text Tool, Text Option appears on the left bottom of 
the window. You can choose the text setting here. 

Font 
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Specifies text font  
Font Type 

Specifies font type. You can choose from plain, bold, italic and 
bold italic. 

Font Size 

Specifies font size.   

 Undo 
Cancels the last action (operation). 
Shortcut:  Win  Ctrl   Z    Mac  Command   Z  

        

 Zoom & Drag Tool 
Expand or scale down display on the screen.  Operation methods are as 
follows: 

l Zoom in 

Click with mouse and press the mouse button on canvas to zoom in. 
Hold the press to expand more.  

l Zoom out 

Ctrl or Command＋click、Ctrl or Command＋hold the press. 
l Canvas Drag 

Drag with mouse 
 

Also, you can use the following key control, even when this tool is not selected. 
Zoom in： Z 	
 Zoom out： X 	
 Canvas drag：drag as you press  SPACE   

Multi Tool 

Some tool buttons are hiding multiple tools. 
When you press and hold the mouse on a Multi Tool, 
other hidden tools come out.    
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Brush Palette and Brush Panel 

Brush Palette 

 
 The Brush palette shows the thickness of the line when you draw with the 
pen or shape tool. Also, when an object is selected, it shows the thickness of 
the line selected. 
Click Brush Palette to open brush panel.  

Brush Panel  

 

Select the line thickness you like from many thicknesses available. 
You can also change the thickness by moving the slider on the bottom. 

Show Brush Panel Option 
Click “Edit Buttons” to show Brush Panel Option 

 

 
 
→ 
← 

 

Click on “Edit Buttons” （triangle on the right) to open/close the option. 

Make a new brush 
Click on the last open space on the Brush Panel to add a new brush. The new 
brush’s thickness can be adjusted with the slider. 
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Color Palette and color Panel 

Color Palette 

 

The Color Palette shows the color currently selected. When you draw on 
canvas, this color is used. Also, when you select an object, it reflects the color 
of the object.  

Recently Used Colors 
If you use the color on the color palette to draw on canvas, the colors are 
accumulated  

 

on “Recently Used Colors” under Color Palette. 
You can choose color from here, too.  

Color Panel 
Click on Color Palette to open the Color Panel.  

  
There are many colors available in the Color Panel  
If you select any color in here, your current color becomes the color.  

l  Colors being used 
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Colors with a dot “・” in the middle are the ones being used on the canvas.  

l Index Number 

In the figure above, #13  is a color index number. Colors are numbered as 
“0123...” from the top low on the left.  

l RGB／HSV Button 

If you move the sliders next to the letters, “RGB, you can adjust the RGB of 
the current palette colors.  
In addition, if you click on the area with “RGB” on it, the display changes to 
“HSV” and adjustment by HSV becomes available.  

l RGB／HSV とは？ 

RGB represents RED, GREEN and BLUE. It is said that we can make 
about 16 million colors by adjusting them. Also, if you click on the 
area with “RGB” on it, the display changes to “HSV” and you can 
adjust color by H (hue), S (shade) and V (Vividness). 

l α 

Sets transparency of the current palette colors.  

Display Color Panel Options 
Click on “Edit Buttons” to display Color Panel Options.  

s  

 
 
 
→ 
← 

 

Click “Edit Buttons”(the triangle on the right) to display options.  
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Make New Colors 
Click on the last open space on the color panel to add new colors. The color can 
be adjusted with RGB/HSV sliders.  
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AnimClip 

Create AnimClip 
Select an object and go to “Animation > Create AnimClip” in the menu.  

Setting AnimClip Properties 

 

l Peg 

Creates AnimClip on Peg mode. On Peg mode, you pin the object, drag it with 
the mouse and record the movement. You can record multiple pin movement 
in layers.   

l Baton 

Creates AnimClip on Baton mode. On Baton mode, you place pins on the 
character, move them to register poses of the character, and then record the 
movement between poses by mouse drag.  

l Name of AnimClip 

Names an AnimClip that you are about to create.  

AnimClip Panel 
AnimClip Panel controls AnimClip. The icons are different on Peg mode and 
Baton mode, but the left half is for mode switch and the right half is a control 
panel for recording image/sound.    
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Mode Switch 

l On Peg mode 

 

l Motion mode 

Switches to “Motion mode”, which creates moving (places) animation   

l Peg mode 

Switches to “Peg mode”, which creates transforming animation  

l Sound mode 

Switches to “Sound mode”, which records sound  

l On Baton mode 

 

l モーション・mode 

Switches to “Motion mode”, which creates moving (places) animation   

l Baton・mode 

Switches to “Baton mode”, which creates transforming animation  

l サウンド・mode 

Switches to “Sound mode”, which records sound  
 

To switch the AnimClip Panel between Peg mode and Baton mode, go to menu 
and select “Animation > AnimClip Properties”.  
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Motion mode 

When you select  on AnimClip Panel, it becomes “Motion mode”, which is 

used to record moves (place to place) of the AnimClip. 

l AnimClip on Motion mode 

 

l AnimClip itself 

The area framed by the blue line is AnimClip itself. Underneath is the 
AnimClip Panel that controls AnimClip. On Motion mode, it drags the 
whole AnimClip itself.  

l Name 

Showing the name of the AnimClip. Double click to display “AnimClip 
Properties” dialogue.  

l Rewind 

Rewind the recording to the beginning 

l  Record 
Press this button and drag the AnimClip itself. The movement is 
recorded and become an animation.   
If you drag the AnimClip without pressing this button, the place 
becomes the starting point of the animation.  

l  Play 
Plays recorded animations.   
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l  Repeat  

Keeps playing repeatedly when this is ON.  

l  Delete Recordings 

Deletes recorded motion-anime  

l  Edit Track 

Edits the track of recorded animation 

Peg mode 

Select  on AnimClip Panel to turn on “Peg mode” that records 

transformations.  

l An AnimClip on Peg mode 

 

l Pin 

Click on the AnimClip area framed by the blue line, to add a pin, a 
transformation key, on the spot. 

l Active Pin 

When you move the mouse over a pin, the pin becomes yellow. You 
can transform the AnimClip by just click and drag it. Click on the pin 
when it is yellow to delete it.  

l  Reset 

Resets the transformation and bring it back to its original shape.  
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l  Rewind 

Rewinds to the beginning 

l  Record 
Press this button and drag an entire AnimClip to record the 
movement, which becomes an animation.  
If you record other pin’s movement, it records in layers, where you can 
create complicated movement.  
※You can record only from the beginning. If you cannot click this 
button, use “Rewind” button to bring back to the beginning.   

l  Play 
Plays recorded animation. 

l  Repeat  

Keeps playing repeatedly when this is ON.  

l  Delete Recordings 

Deletes motion anime recordings.  

l  Edit Track 

Edits the track of recorded animation. 
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Baton mode 

Select  on AnimClip Panel to turn on Baton mode, which records 

transformations.  

l AnimClip on Baton mode 

 

l Pin 

Click on the AnimClip area framed by the blue line, to add a pin, a 
transformation key, on the spot. 

l Active Pin 

When you move the mouse over a pin, the pin becomes yellow. You 
can transform the AnimClip by just click and drag it. Click on the pin 
when it is yellow to delete it.  

l Baton Panel 

When you create an AnimClip for Baton mode, Baton Panel appears. 
In Baton Panel, “Baton Ball” and “Pose knot” are placed. 

l  Pose Knot 

When you register a pose, this, Pose Knot, appears in Baton Panel. 
Click and drag to move.  

l  Baton Ball 

Move this to smoothly transform an AnimClip between poses.  

l  Add Pose 
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Registers the shape of the current AnimClip as a pose.  appears in 

the Baton Panel.  
l  Remove Pose 

Select a Pose Knot in Baton Panel and click it to remove the pose.  

l  Reset 

Resets the transformation and bring it back to its original shape.  

l  Rewind 

Rewinds to the beginning 

l  Record 
Press this button and drag an entire AnimClip to record the 
movement, which becomes an animation.  
If you record other pin’s movement, it records in layers, where you can 
create complicated movement.  
※You can record only from the beginning. If you cannot click this 
button, use “Rewind” button to bring back to the beginning.   

l  Play 
Plays recorded animation. 

l  Repeat  

Keeps playing repeatedly when this is ON.  

l  Delete Recordings 

Deletes motion anime recordings.  

l  Edit Track 

Edits the track of recorded animation. 

l  Record 

Press this button, and drag  Baton Ball in the Baton Panel to 

record the movement. AnimClip transforms to match the movement 
and becomes an animation.  
※You can record only from the beginning. If you cannot click this 
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button, use “Rewind” button to bring back to the beginning.   

l  Play 
Plays recorded animation. 

l  Repeat  

Keeps playing repeatedly when this is ON.  

l  Delete Recordings 

Deletes motion anime recordings.  

l  Edit Track 

Edits the track of recorded animation. 
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Timeline 

Open Timeline 

 

Click on the triangle on the left top of the window or select “Window > 
Timeline” in Menu to display Timeline.  
Shortcut: Win  Ctrl   T    Mac  Command   T  

Timeline: Name and Function of Each Parts 

 

l  Frame 

The rectangles lined up over Timeline are called “frames”. It is 
equivalent to a sheet (page) of flipbook. In the early stage, there is only 
one frame.    

l  Play head 

The red vertical line, called the “Play head” indicates the frame that is 
currently displayed. It moves toward right as the animation plays. 
You can move it in the frame by dragging the thick red part or clicking 
this area.  

l  Blank Key-frame 

There is a white ○ in the draw frame. This frame is called “Blank 
Key-frame”.  This is a Key-frame that has nothing drawn on it, yet.  

l  Key-frame 
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When there is an object on the canvas, it changes to a black ●. It 
indicates that the picture in this frame, called “Key-frame”, changes 
in the frame.  

l  Frame Information  

On the left under the timeline, you see “24fps” indicated.  The “fps” is 
an abbreviation of “frames per second”.  24fps means that 24 frames 
are played in 1 second. The “#” in the middle shows the location of the 
play head in the frame. The clock mark on the left indicates how many 
second has passed from the start. 

Frame Control 
Icons on the bottom left of the Timeline panel are mainly for frame controls.  

l  Add Frame 

Click when a Key-frame or a Blank Key-frame is selected to insert a 
frame.  

Shortcut:	
 	
 Win/Mac  F5   

l  Add Key-frame 

Adds a Key-frame. The added frame takes the object from the last 
Key-frame.   

Shortcut:	
 	
 Win/Mac  F6   

l  Add Blank Key-frame 

Adds a Blank Key-Frame. The added Key-frame has no object and is 
blank. 
Shortcut:	
 	
 Win/Mac  F7   

l  Add Tween Key-frame 

Adds a Key-Frame for Tween. 
l Remove Frame 

Removes Frame 
Shortcut:	
 	
 Win/Mac  Shift   F5  

l  Remove Line／Key-frame 
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Removes selected Key-frame or Tween setting. 
Shortcut:	
 	
 Win/Mac  Shift   F6  

l  Onion Skin（Make frames, in front and behind, transparent)  

Shows the contents of the frames in front and behind of the selected 
frame semi-transparently. The feature is useful when you want to 
draw as you watch the situation in those frames before and after.  

Play Control  
When two or more frames exist on Timeframe, a group of icons for playing 
animation appears. This remains on the window even if you close Timeline.  

 

l  (To the) First Frame 

Click to move the play head to the beginning of the first frame 
Shortcut:	
 	
 Win/Mac  Shift   1  

l  (To the) Previous Frame 

Click to move the play head to the previous frame. 
Shortcut:	
 	
 Win/Mac  1  

l  Play / Stop 

Click to play the animation from the point where the play head is 
currently positioned. Click again to stop playing.  

Shortcut:	
 	
 Win/Mac  4  

 

l  (To the) Next Frame 

Click to move the play head to the frame right behind the current 
frame.  

Shortcut:	
 	
 Win/Mac  2  

l  (To the) Last Frame 

Click to move the play head to the last frame 
Shortcut:	
 	
 Win/Mac  Shift   2  
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Preferences 

 In “Preferences”, you can specify the basic settings that apply to entire PICMO 
Program.  

Open Preferences 
Select “Preferences” from the menu to show Preference settings dialogue box 
to specify your preferences. You can find it under “Edit” menu for Window and 
under “PICMO-xxx” for Macintosh.（Paint／Animation／Pro goes in the place 
of “xxx”）This menu is given the following shortcut: 
Shortcut: Win  Ctrl   K    Mac  Command   K  

Preference ＞ General 

 

l Language 

You can switch the system language between Japanese and English. 
(Re-launch PIMCO to make the change come into effect.)   

l Files Used Recently  

Changes the number displayed on recently used files. (Re-launch PIMCO to 
make the change come into effect.)   

l Undo Levels 
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Changes the number that you can undo with “Undo”. (Re-launch PIMCO to 
make the change come into effect.)   

l Tool Panel (and Palette Arrangement) 

Changes the arrangement of the Tool Panel and Palette to be on both sides 
(one for each) or on left side (for both).  

l Document Thumbnail (Positioning) 

Changes the position of thumbnail to be on the bottom or right.   

l Thumbnail Size 

Changes the size of thumbnails. 

l Popup Hidden Panel 

Check to let a hidden panel popup as a reaction to the mouse. 

l Don’t Display Until New Information (Notice).  

Check to withhold displaying notice when you start-up application until new 
information becomes available.   

Preference ＞ Display 

 

l Anti Aliasing (Quality)  
Specifies the quality setting of anti-aliasing. When you raise anti-aliasing 
quality, the screen display becomes smooth, but slows down the operation.  
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l Default Canvas View 

Sets the size of the canvas in the window.  

l Actual Size 

The canvas is displayed in actual size (pixels). Canvas size remains 
the same even if you change the size of the window. 

l Smart Fit 

The canvas is adjusted to an appropriate size to fit the window size 
automatically. When you change the window size, the canvas follows 
automatically.   

l Fit to Window 

The canvas size is set to fill up the window automatically.  When you 
change the window size, the canvas follows automatically.   

l Transparent as... 

When you create a new document with PICMO, the background is set to be 
transparent. This section specifies how it displays “transparent”.  

l White 

“Transparent” is displayed as white. 
l Black 

“Transparent” is displayed as black.  
l Tile 

“Transparent” is displayed as a tile pattern. 

l Transparent Layer 

Sets the level of transparency on the other layers when the Layer button is 
pressed or a layer is shown semi-transparent using the “Eye” icon on the 
Layer bar.  

l Disable Real-time Smoothing 

Speeds up operation by disabling complicated real-time smoothing during 
drawing. Select when the operation is very slow with Windows.  
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Preference ＞ Draw 

 

l Scale Line Width 

Check to scale line widths accordingly when the object is 
enlarged/scaled-down. 

l Enable Pen Smoothing 

Check here to smoothen lines drawn with the Pen Tool. It controls the 
wobbliness of the lines when it is ON. Turn it OFF if you feel that the line is 
getting caught on the canvas when you are drawing.  

l Color Chips’ Size 

Specifies the size of the color chips in the color palette.  

l Colors Used Recently 

Specifies the number of colors displayed in the window as “colors used 
recently”  (Re-launch PIMCO to make the change come into effect.) 
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Preference ＞ Animation 
Specifies preferences regarding animation.  
 

  
l AnimClip：Peg Mesh Size 

PICMO utilizes a triangle structure internally to realize smooth 
transformations of AnimClip. This setting specifies the size of the triangle. 
When the value is small, the transformation result can be smooth; however, it 
complicates the operation and the action may become heavy. In some cases, 
the PC may freeze.   

l Timeline：Auto Insert Key-frame 

Sets to insert the Key-frame automatically. If you place a check here, when 
you draw a picture in the frame that is not a Key-frame, the frame becomes a 
Key-frame automatically.  

l Onion Skin Frame Count 

Sets the number of frames to display semi-transparently when you use the 
onionskin function.  

l Sound File：Embed Sound data 

Check here to embed sound data in PICMO data when you import sound data. 

l Sound recording minimum click time (interval)  
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Specifies the recording intervals to prevent unexpected repeats when you 
record sound.  
 

Preferences ＞ YouTube 
Sets an account to be used for posting on YouTube.  
 

  
l Use common account  

Uses a YouTube account exclusively for PICMO. Animations are uploaded on 
PICMO Channel (Account name: PIMO Box).  

l Use user account  

Uses your individual YouTube account. Animations are uploaded on the user 
account area. User name and password are required.  
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Preferences ＞ Advanced 
Preferences for computer and CG experts.  

  
l Timing to close the dropdown window 

Sets the timing to close the dropdown window. 

l Transparency of panel  

Specifies transparency of the brush or color palette.  

l Scale: Click Accuracy： 

Sets how far a click can be to select stroke. You can adjust the selection 
distance when the area and the stroke are close to each other.  

l Use Expert Mode for Bitmap Importing 

Sets to use Expert Mode for Bitmap Importing. If you place a check here, you 
can set the level of “Smoothness of filtering” and “Anti Key Color (of 
background)” when you import images.  

l Using Memory Size 

Changes the memory size that PICMO uses. When you are handling 
complicated control or the animations become very long, and the operation 
becomes unstable, increase the number here.（(Re-launch PIMCO to make the 
changes come into effect.) 
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Restrictions on Trial Version 

PICMO can be used for free as a trial for a certain period of time until you register 
the product. There are restrictions set for the trial period. It may cause 
inconvenience, but we hope that you will register and utilize our product for a long 
time.  Thank you.  

l You cannot save file 

l When you export files to Flash SWF or QuickTime, they will be marked as trial 

version.  

 



	
 

 

About the Library 

License and copyright information of library used in PICMO is shown below.  
 

l JOGL: Java bindings for OpenGL 

Copyright (c) 2003-2006 Sun Microsystems, Inc. All Rights Reserved. 
https://jogl.dev.java.net/ 

l Java SWF: A pure Java wrapper for the Macromedia Flash file format. 

Copyright (c) 2001-2005, David N. Main, All rights reserved. 
http://sourceforge.net/projects/javaswf/ 

l JAMA : A Java Matrix Package 

Copyright (c) The MathWorks and the National Institute of Standards 
and Technology (NIST) 
http://math.nist.gov/javanumerics/jama/ 

l kXML 

http://kxml.objectweb.org/index.html 

l Log4j 

Copyright (C) 1999-2006, Apache Software Foundation. Licensed 
under the Apache License, Version 2.0. 

l Free HEP Java library 

FREEHEP - Copyright 2000, CERN, All rights reserved. 

l UMPACK 

UMFPACK Version 5.0, Copyright 1995-2006 by Timothy A. Davis. 
All Rights Reserved. 
http://www.cise.ufl.edu/research/sparse/umfpack 

l Qubic2Quadratic.java 

@author Shazron Abdullah (shazron 'at' stormgate.com), Feb 2002 
(Java port) 
Original code Copyright (C) 2001  Opaque Industries - 
http://www.opaque.net 



	
 

 

Copyright Information 

l “PICMO” is a trademark of Chelico Entertainment Inc. 

l Images and animations that a customer created using PICMO is a work of the 

customer and can be distributed without restrictions. However, Chelico Entertainment 

Inc. and its licenser reserve the right to re-use the animations posted on YouTube 

PICMO channel free of charge.  We consider that the user agrees with this term at 

the time he/she posts on YouTube.  

l The copyright of the character used for PICMO logo belongs to UrumaDelvi and 

Productions Inc.  

 

 


